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Technical Support
Symantec Technical Support maintains support centers globally. Technical
Support’s primary role is to respond to specific queries about product features
and functionality. TheTechnical Support group also creates content for our online
Knowledge Base. The Technical Support group works collaboratively with the
other functional areas within Symantec to answer your questions in a timely
fashion. For example, theTechnical Support groupworkswithProductEngineering
and Symantec Security Response to provide alerting services and virus definition
updates.

Symantec’s maintenance offerings include the following:

■ A range of support options that give you the flexibility to select the right
amount of service for any size organization

■ Telephone and Web-based support that provides rapid response and
up-to-the-minute information

■ Upgrade assurance that delivers automatic software upgrade protection

■ Global support that is available 24 hours a day, 7 days a week

■ Advanced features, including Account Management Services

For information about Symantec’sMaintenance Programs, you can visit ourWeb
site at the following URL:

www.symantec.com/techsupp/

Contacting Technical Support
Customerswith a currentmaintenance agreementmay access Technical Support
information at the following URL:

www.symantec.com/techsupp/

Before contacting Technical Support, make sure you have satisfied the system
requirements that are listed in your product documentation. Also, you should be
at the computer onwhich theproblemoccurred, in case it is necessary to replicate
the problem.

When you contact Technical Support, please have the following information
available:

■ Product release level

■ Hardware information

■ Available memory, disk space, and NIC information

■ Operating system

www.symantec.com/techsupp/
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■ Version and patch level

■ Network topology

■ Router, gateway, and IP address information

■ Problem description:

■ Error messages and log files

■ Troubleshooting that was performed before contacting Symantec

■ Recent software configuration changes and network changes

Licensing and registration
If yourSymantecproduct requires registrationor a licensekey, access our technical
support Web page at the following URL:

www.symantec.com/techsupp/

Customer service
Customer service information is available at the following URL:

www.symantec.com/techsupp/

Customer Service is available to assist with the following types of issues:

■ Questions regarding product licensing or serialization

■ Product registration updates, such as address or name changes

■ General product information (features, language availability, local dealers)

■ Latest information about product updates and upgrades

■ Information about upgrade assurance and maintenance contracts

■ Information about the Symantec Buying Programs

■ Advice about Symantec's technical support options

■ Nontechnical presales questions

■ Issues that are related to CD-ROMs or manuals

www.symantec.com/techsupp/
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Maintenance agreement resources
If you want to contact Symantec regarding an existing maintenance agreement,
please contact the maintenance agreement administration team for your region
as follows:

customercare_apac@symantec.comAsia-Pacific and Japan

semea@symantec.comEurope, Middle-East, and Africa

supportsolutions@symantec.comNorth America and Latin America

Additional enterprise services
Symantec offers a comprehensive set of services that allow you tomaximize your
investment in Symantec products and to develop your knowledge, expertise, and
global insight, which enable you to manage your business risks proactively.

Enterprise services that are available include the following:

These solutions provide early warning of cyber attacks, comprehensive threat
analysis, and countermeasures to prevent attacks before they occur.

SymantecEarlyWarningSolutions

These services remove the burdenofmanaging andmonitoring security devices
and events, ensuring rapid response to real threats.

Managed Security Services

Symantec Consulting Services provide on-site technical expertise from
Symantec and its trustedpartners. SymantecConsultingServices offer a variety
of prepackaged and customizable options that include assessment, design,
implementation,monitoring, andmanagement capabilities. Each is focused on
establishing andmaintaining the integrity and availability of your IT resources.

Consulting Services

Educational Services provide a full array of technical training, security
education, security certification, and awareness communication programs.

Educational Services

To access more information about Enterprise services, please visit our Web site
at the following URL:

www.symantec.com

Select your country or language from the site index.
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About Workflow 7.0 and
installation

This chapter includes the following topics:

■ About Workflow 7.0

■ Prerequisites for Workflow 7.0

■ Operating system compatibility

■ Where to get more information about Symantec Workflow 7.0

■ About installing Workflow 7.0

About Workflow 7.0
Symantec Workflow 7.0 provides the Workflow 7.0 capability of advanced logic
and workflow to Symantec Management Console and the Symantec solutions.

For more information on Workflow 7.0, see the Workflow 7.0 User's Guide.

See “Where to get more information about Symantec Workflow 7.0” on page 12.

Workflow 7.0 is not a single piece of software. It has five main pieces—Workflow
Solution,WorkflowDesigner,WorkflowServer, client tools, andProcessManager.
The following table describes each piece:

1Chapter



Table 1-1 Pieces of Workflow 7.0

DescriptionSoftware piece

Workflow Solution is the piece of Workflow 7.0 that is
installed as an integrated solution on the Symantec
Management Platform and is accessible through the
SymantecManagement Console. It facilitates licensing and
reports with the platform. It also integrates Workflow
Designer andWorkflowServerwithSymantecManagement
Platform.This integration letsWorkflow interactwith other
solutions, such as creating tasks that other solutions can
use. The solution piece also lets you distribute components
through the Symantec Management Console.

Workflow Solution

Workflow Designer is the tool used to design processes. It
contains components that you can arrange into processes
and thenpublish to aWorkflowServer. It should be installed
on computers other than the Symantec Management
Platform host. Installation of Workflow Designer is not
required. Workflow Designer is dependent on Workflow
Server to be able to publish workflows.

For more information about Workflow Designer, see the
Workflow 7.0 User's Guide.

Workflow Designer

Workflow Server runs and manages published workflow
projects. It should be installed on any computer to which
you want to publish: a designated server or your local
computer. It is installed automatically when you install
Workflow 7.0. Typically, you should designate a server as
theproductionWorkflowserver and installWorkflowServer
on that server so there is a central location for all
production-ready workflows.

For more information, see theWorkflow Solution User's
Guide.

Workflow Server

ProcessManager is aWeb portal used tomanage published
processes that include human interaction. It should be
installed on a central Process Manager server. Installation
of Process Manager is not required. For a development and
testing environment, install Process Manager on a design
computer. For a production environment, install it on a
central server.

For more information, see theWorkflow 7.0 User's Guide.

Process Manager

About Workflow 7.0 and installation
About Workflow 7.0
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Table 1-1 Pieces of Workflow 7.0 (continued)

DescriptionSoftware piece

Workflow client tools are a tool set that supportsWorkflow
7.0.

The tools are as follows:

■ Business TimeSpan Editor

■ Composer Theme Editor

■ Configuration and Logging Tool

■ Local Machine Info Editor

■ Messaging Console

■ Notification Server Credentials Tool

■ Profiler Tool, Scheduler Tool

■ Server Extensions Configurator

■ Task Tray Tool

■ Tool Preferences Editor

Client tools

Prerequisites for Workflow 7.0
Workflow 7.0 includes a number of pieces that can be installed on the same or
different computers. If you install all of them on one computer, that computer
must meet all the prerequisites listed in the table below. If you install only one
piece listed below, the host computer must meet the prerequisites for that piece.

Table 1-2 Workflow prerequisites

PrerequisitesWorkflow piece

Here are the prerequisites for Workflow Solution:

■ Symantec Management Platform 7.0 SP1, HotFix
1 or greater

■ Microsoft .NET Framework 3.5

■ Symantec Management Platform Webservice 7.0

Workflow Solution

Workflow Server has one prerequisite:

■ Microsoft IIS 5.x or 6.x

Workflow Server

11About Workflow 7.0 and installation
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Table 1-2 Workflow prerequisites (continued)

PrerequisitesWorkflow piece

Here are the prerequisites for Workflow Designer:

■ Microsoft .NET Framework 3.5

■ Workflow Server—Gets installed automatically
during Workflow Designer installation.

■ Optional:Microsoft IIS 5.x or 6.x—An internalWeb
server is delivered with Workflow Designer that
can be used with the debugger.

Workflow Designer

Here are the prerequisites for Process Manager:

■ Microsoft .NET Framework 3.5

■ Microsoft IIS 5.x or 6.x

■ Microsoft SQL Server 2005 or SQL Express

■ Workflow Server - Gets installed automatically
during Workflow Designer installation.

Process Manager

Operating system compatibility
Workflow 7.0 is compatible with several operating systems. Although you can
runWorkflowDesigner, Server, ProcessManager, andSolution onmanyoperating
systems, run them only on the operating systems listed below in a production
environment.

Table 1-3 Operating system compatibility

SolutionProcess ManagerServerDesigner

WorkflowSolutionsupports
all operating systems
supported by Symantec
Management Console.

■ Windows Server 2003
R2 SP2 32-bit

■ Windows Server 2003
R2 SP2 64-bit

■ Windows Server 2003
R2 SP2 32-bit

■ Windows Server 2003
R2 SP2 64-bit

■ Windows XP SP3 32-bit

■ Windows Vista SP2
32-bit

Where to get more information about Symantec
Workflow 7.0

For more information, refer to the information sources in the following table.

About Workflow 7.0 and installation
Operating system compatibility
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Table 1-4 Where to get more information

LocationInformation source

www.workflowswat.comWorkflow SWAT

https://.kb.altiris.comSymantecManagementPlatform7.0Release
Notes

https://.kb.altiris.comAltiris 7.0 Planning and Implementation
Guide

https://.kb.altiris.comInstalling the Symantec Management
Platform 7.0 products

https://.kb.altiris.comKnowledge Base

http://www.symantec.com/connect/Symantec Connect

About installing Workflow 7.0
Depending on whether you are installing Workflow for the first time, the
installationprocesshas threemain steps: installing throughSymantec Installation
Manager, downloading the installer throughSymantecManagement Console, and
running the installer.

See “Installing Workflow for the first time” on page 14.

Workflow 7.0 has only one installer for numerous pieces. While installing you
can click which pieces of Workflow 7.0 you want to install.

See “About Workflow 7.0” on page 9.

Although you have a lot of flexibility with how you install Workflow 7.0, every
installation must conform to the following parameters:

■ Workflow Solution must be installed in Symantec Installation Manager.

■ Workflow Server must be installed on every computer running Workflow 7.0
(this is done automatically with every Workflow install).

Although Workflow Server always gets installed with Workflow Designer or
Process Manager, you should designate a server as the production Workflow
server and installWorkflowServer on that server. This creates one central location
for all production-ready workflows.

You do not have to install either Workflow Designer or Process Manager when
you installWorkflowServer. For a typical production environment, install Process
Manager only on a central server, and install Workflow Designer only on design

13About Workflow 7.0 and installation
About installing Workflow 7.0
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computers. For a development and testing environment, install these two pieces
of Workflow on a design computer.

Installing Workflow for the first time
Refer to the following steps if you are installing Workflow for the first time. If
you are upgrading from Workflow 6.5, see the following section:

See “Upgrading from Workflow 6.5” on page 15.

InstallingWorkflowhas threemain steps: installing throughSymantec Installation
Manager, downloading the installer throughSymantecManagement Console, and
running the installer.

Table 1-5 Process for installing Workflow 7.0

DescriptionActionStep

Installing Workflow through the
Symantec Installation Manager makes
Workflow available in Symantec
Management Console. Once you have
installed Workflow through the
Symantec InstallationManageryoucan
download the installer through the
Symantec Management Console.

See “Installing Workflow Solution
through Symantec Installation
Manager” on page 21.

Install Workflow through the
Symantec Installation Manager

Step 1

A link to the Workflow installer is
available in Symantec Management
Console. Clicking this link downloads
the Workflow installer to your local
computer.

See “Downloading the Workflow
installer through the Symantec
Management Console ” on page 22.

Download the Workflow installer
through Symantec Management
Console

Step 2

About Workflow 7.0 and installation
About installing Workflow 7.0
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Table 1-5 Process for installing Workflow 7.0 (continued)

DescriptionActionStep

Run the Workflow installer to install
Workflow on your local computer.
There is only one installer for all the
pieces of Workflow.

See “Installing Workflow Server”
on page 27.

See “Installing Workflow Designer”
on page 29.

Install WorkflowStep 3

Upgrading from Workflow 6.5
Refer to the following steps if you are upgrading Workflow 6.5 to Workflow 7.0.
If you are installing Workflow for the first time, see the following section:

See “Installing Workflow for the first time” on page 14.

You candisrupt currently-runningWorkflow6.5 processes by installingWorkflow
7.0 if you do not keep the same persistence settings. Ideally, you should use the
samepersistence settings forWorkflow7.0 that youused forWorkflow6.5. During
installation you can set the persistence setting forWorkflow7.0. If the persistence
setting in Workflow 6.5 is not supported in Workflow 7.0, version your projects
so you do not overwrite the currently-running processes.

See “Versioning a process” on page 19.

If you do not know what persistence settings your current version of Workflow
is using, refer to the following section:

See “Determining a project's persistence setting” on page 17.

Symantec recommends using the following steps to upgrade your
currently-running processes from Workflow 6.5 to Workflow 7.0:

Table 1-6 Process for upgrading currently-running processes

DescriptionActionStep

Create packages for all your projects, and store these packages
on a safe directory.

For more information on creating a project package, see the
Workflow 7.0 User's Guide.

www.alitis.com/support/documentation.aspx

Backup your projectsStep 1

15About Workflow 7.0 and installation
About installing Workflow 7.0
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Table 1-6 Process for upgrading currently-running processes (continued)

DescriptionActionStep

Create a backup of your Ensemble database. Store the database
backup on a safe directory.

Backup the Ensemble databaseStep 2

Install Workflow 7.0 on a testing computer.

See “Installing Workflow for the first time” on page 14.

If you already have a testing computer setup up with Workflow
7.0, you do not need to set up another one.

While you are installing on your testing computer, make sure
you do the following:

■ Use the sameWorkflowpersistence settings as yourWorkflow
6.5 configuration.

If you do not know what persistence setting you are using in
Workflow 6.5, see the following section:

See “Determining a project's persistence setting” on page 17.

If you are using a persistence setting that is not supported by
Workflow 7.0, see the following section:

See “Versioning a process” on page 19.

■ Set Workflow 7.0 to have access to a Symantec Management
Platform 7.0 server (NS 7).

Install Workflow 7.0 on a testing
computer

Step 3

Open each project and make the necessary changes for it to be
compatible with Workflow 7.0 and Symantec Management
Platform 7.0. Change any old Notification Server components
and settings.

If you can use the same persistence setting for your Workflow
7.0 projects as you used for your Workflow 6.5 projects.

See “Determining a project's persistence setting” on page 17.

Revise your projectsStep 4

Publish the revised projects to the Workflow 7.0 computer. For
more information on publishing projects, see theWorkflow 7.0
User's Guide.

Publish revised projects to
Workflow 7.0 computer

Step 5

Conduct thorough tests to ensure that your projects areworking
properly in aWorkflow7.0 andSymantecManagementPlatform
7.0 environment. If you encounter any problems, fix the project
and republish.

Test revised projectsStep 6

About Workflow 7.0 and installation
About installing Workflow 7.0
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Table 1-6 Process for upgrading currently-running processes (continued)

DescriptionActionStep

Install Workflow 7.0 on your production computer. When you
install, make sure you use the same persistence setting as you
6.5 configuration.

See “Installing Workflow Server” on page 27.

See “Installing Workflow Designer” on page 29.

Install Workflow 7.0 on
production computer

Step 7

Publish all of your revised projects to the Workflow 7.0
production computer. For more information on publishing
projects, see theWorkflow 7.0 User's Guide.

Publish revised projects to
production computer

Step 8

Determining a project's persistence setting
Persistence refers to how a running process is stored in memory to improve the
performance of Workflow 7.0. Persistence is set at the project level, but most
projects use the default setting that was set whenWorkflowwas installed (almost
always file-based). ForWorkflow6.5 projects, the persistence setting is configured
under theproject'sPublishingdata tab in theWorkQueueServiceNameproperty.

The best way to determine a project's persistence setting is to open the project
and look at its Work Queue Service Name property under the Publishing data
tab.

For more information on data tabs, see theWorkflow 7.0 User's Guide.

The following table describes persistence options:

Table 1-7 Persistence options

DescriptionPersistence option

Uses Ensemble SQL database settings. The workflow
project uses the Ensemble database for persistence.

There is no Workflow 7.0 equivalent of this setting.

LogicBase.Components.Ensemble.WSWorkQueue

17About Workflow 7.0 and installation
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Table 1-7 Persistence options (continued)

DescriptionPersistence option

Uses Exchange for persistence. This is themost common
persistence setting. This setting uses either file-based or
SQL-based persistence over Exchange.

For informationondeterminingwhether this settinguses
file-based or SQL-based persistence, see the following
section:

See “To determine the default persistence setting in the
Configuration and Logging Tool” on page 18.

The Workflow 7.0 equivalent of this is Exchange
(file-based) or SQL-based persistence. You can set this
when you install Workflow 7.0.

LogicBase.Components.Default.ExchangeAdapters.
LogicBaseExchangeWorkQueue

Uses direct file-based persistence.

There is no Workflow 7.0 equivalent of this setting.

LogicBase.Core.Workflow.FileSystemAdapters.
FileSystemWorkQueue

Uses internal Workflow memory.

There is no Workflow 7.0 equivalent of this setting.

LogicBase.Core.Models.Workflow.InMemoryWorkQueue

Uses direct SQL-based persistence.

There is no Workflow 7.0 equivalent of this setting.

LogicBase.Core.Workflow.SQLServerAdapters.
SQLServerWorkQueue

Your projects are probably set to use
LogicBase.Components.Default.ExchangeAdapters.LogicBaseExchangeWorkQueue.
If this is the case, you can determine whether the exchange is set to file-based or
SQL-based persistence in the Configuration and Logging Tool.

See “Todetermine thedefault persistence setting in theConfiguration andLogging
Tool” on page 18.

If any of your projects use a persistence setting other than
LogicBase.Components.Default.ExchangeAdapters.LogicBaseExchangeWorkQueue,
you should version them to avoid losing process data.

See “Versioning a process” on page 19.

To determine the default persistence setting in the Configuration and Logging Tool

1 Open the Configuration and Logging Tool.

Start > Programs > Altiris > Workflow Designer > Tools > Configuration
and Logging Tool.

2 Click the Exchange Configuration tab.

About Workflow 7.0 and installation
About installing Workflow 7.0
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3 In the left pane, click local.config : LBQ_Local_Defaults.

4 In the right pane, double-click local.workflow-.

If the Deliver To Queue property is set to LBME.Workflow (with a prefix),
the default persistence setting is file-based.

If the Deliver To Queue property is set to workflowsqlexchange (with a
prefix), the default persistence setting is SQL-based.

Versioning a process
If you have a Workflow 6.5 project that uses a persistence setting that is not
supported in Workflow 7.0, version the project so you do not lose any process
data (such as tasks).Process versioning is handled in IIS. When you publish a
workflow project, a new virtual directory is created in IIS, unless one of the same
name already exists. If an identical one exists, the new process overwrites the
process alreadypublished there. Anewvirtual directorymust be created to contain
the updated processwhile the old process is allowed to run in its virtual directory.
The following steps assume that you have a currently running process you are
replacing with an updated version.

Versioningworks onlywith the “PublishApplication to Server” publishing option.
Because the other publishing options do not let you set the virtual directory name,
you cannot use versioning with them.

To version a process

1 In Workflow Designer, when you are ready to publish your updated process,
click File > Publish Project > Publish Application to Server.

2 In the Virtual Directory field, add the updated version number to the end of
the name of the virtual directory.

For example, if the old process is in a virtual directory called “PurchaseOrder,”
call the new virtual directory “PurchaseOrder2.0.” If you publish without
changing the name of the virtual directory, your new processwill completely
replace the old one and break any of its current instances.

3 Complete the publishing process as normal.

4 Repoint the invocation links to the virtual directory of the updated process.

In other words, whatever invoked the old process (such as Process Manager
service catalog item or external link) must be repointed to the new virtual
directory that contains the process.

5 After the old process has finished all activity, delete its virtual directory.

19About Workflow 7.0 and installation
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Installing Workflow 7.0

This chapter includes the following topics:

■ Installing Workflow Solution through Symantec Installation Manager

■ Downloading the Workflow installer through the Symantec Management
Console

■ Possible installation configurations

■ Installing Workflow Server

■ Installing Workflow Designer

■ Installing Process Manager

■ Configuring Workflow 7.0

Installing Workflow Solution through Symantec
Installation Manager

See “About installing Workflow 7.0” on page 13.

Before you can download the Workflow 7.0 installer through the Symantec
Management Console, you need to install Workflow 7.0 through the Symantec
InstallationManager. InstallingWorkflow 7.0 through the Symantec Installation
Manager registersWorkflowas anavailable product in theSymantecManagement
Console.

The followingKnowledgeBase article providesmore information on the Symantec
Installation Manager:

https://kb.altiris.com/article.asp?article=45732&p=1
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To install Workflow 7.0 through the Symantec Installation Manager

1 In the Symantec Installation Manager, click Install new products.

Navigate to the Symantec InstallationManager by clicking Start>Programs
> Altiris > Symantec Installation Manager.

Make sure you are using the correct XML file in Symantec Installation
Manager settings. You should use
http://www.solutionsam.com/solutions/pl/symantec.pl.xml.

2 Set the filter to None.

Symantec Workflow Solution 7.0 appears when you set the filter to None.

3 Click the SymantecWorkflowSolution7.0 check box, and then click Review
selected products.

Depending on what you have already installed, youmay need to install other
prerequisites. The Symantec Installation Manager alerts you if you need to
install prerequisites.

4 Click Next.

5 Complete the installation wizard.

Let the Workflow download finish before you start the installation.

6 (Optional) migrate links from Notification Server.

Select this option if youwant tomigrate links to your old item actions, dialog
workflows, and tasks from Notification Server 6.5 to the Symantec
Management Console.

See “Migrating links from Notification Server 6.5 to Symantec Management
Platform 7.0” on page 35.

Downloading the Workflow installer through the
Symantec Management Console

See “About installing Workflow 7.0” on page 13.

Once youhave installedWorkflowSolution in the Symantec InstallationManager,
you can download the Workflow 7.0 installation file through the Symantec
Management Console. You need to download the installer before you can install
Workflow.

See “Installing Workflow for the first time” on page 14.
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See “Installing Workflow Solution through Symantec Installation Manager”
on page 21.

To download the installation file through the Symantec Management Console

1 In the Symantec Management Console, on the Settings menu, click All
Settings.

2 In the left pane, expand Service and Asset Management, and then expand
Workflow.

3 Double-click Manage Workflow Servers.

4 In the right pane, click DownloadSymantecWorkflowServerandDesigner
(All license levels).

5 Run the installer.

See “Installing Workflow for the first time” on page 14.

Possible installation configurations
Before you run the Workflow 7.0 installer, you should decide what installation
configuration you want to use. You can install the pieces of Workflow 7.0 in a
number of different configurations based on organizational need. For example,
you can reduce the processing load by installing background processing on a
different server than your primary Workflow server.

Refer to the following list for some common installation configurations:

■ Testing configuration
Testing configurations commonly install all the pieces of Workflow 7.0 on a
single server. Alternately, you can install Workflow Server and Process
Manager on virtual machines to simulate a muliple-server configuration for
testing purposes.

■ Designer configuration
Designer configuration commonly install onlyWorkflowServer andWorkflow
Designer on a development computer. The task tray application on the
development computer is configured with the Workflow Server and Process
Manager server used for production publishing.

■ Separate background processing configuration
Aseparatebackgroundprocessingconfiguration installs backgroundprocessing
on a different server than the primary Workflow server to reduce processing
load.
See “Installing with separate background processing” on page 24.
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Installing with separate background processing
You can install the background processing forWorkflow 7.0 on a different server
than your primary Workflow server. Background processing refers to timeouts
and escalations in your workflow processes.

Table 2-1 Installing with separate background processing

DescriptionActionStep

InstallWorkflowServer, Designer, ClientTools, ProcessManager
Database, Process Manager Portal, and Process Manager Portal
Core on the primary Workflow server.

The primary server is the central location where you publish
your processes. The primary server may also be the primary
Process Manager server, depending on your configuration.

InstallWorkflow 7.0 normally on your primary server, using the
following settings:

■ Deselect Background Processing.
■ Select all other pieces youwant to run on the primary server.

■ Use all default settings, including SQL persistence with a
Process Manager database connection setting.

Install Workflow 7.0 on the
primary server

Step 1

Install only Workflow Server and background processing on the
secondary Workflow server.

Install Workflow 7.0 normally on your secondary server, using
the following settings:

■ Select only Background Processing and Workflow Server.
■ Select Show Advanced Settings During Installation.

■ For persistence settings, selectBasedonSQLserverdatabase
and Custom Settings for the database connection.

■ For the customdatabase connection string, use the following:

Data Source=(Name of primary server);Initial

Catalog=Ensemble;User ID=sa;Password=Your

password;Pooling=true;Connection Timeout=300;

Install background processing on
the secondary server

Step 2

Edit the task tray settings on the primary and secondary servers
to connect them.

See “Adding connection settings between the primary and
secondary servers” on page 25.

Connect the primary and
secondary servers

Step 3
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Table 2-1 Installing with separate background processing (continued)

DescriptionActionStep

Create and publish a test project to test the separate background
processing.

See “Testing a separate background processing configuration”
on page 26.

Test the configurationStep 4

Adding connection settingsbetween theprimary andsecondary
servers
After you have installed Workflow 7.0 in a separate background processing
configuration, edit the task tray settings on the primary server (main Workflow
server) and the secondary server (background processing server).

To add connection settings

1 On the primary server, add the secondary server to the task tray connection
settings.

■ On the primary server, double-click the task tray application.

■ Click Add.

■ Configure the settings for your secondary server, and then click OK.

2 On the secondary server, add the primary server to the task tray connection
settings.

■ On the secondary server, double-click the task tray application.

■ Click Add.

■ Configure the settings for your primary server, select
LogicBase_ProcessManager for the server role, and then click OK.

3 Click the Default Server drop-down list and click the primary server.

Note: Because the default polling interval is set to twenty-four hours, the
background processing may not start immediately. If you want it to start
immediately, reduce the polling interval (Workflow Server Configuration >
AutoTriggerInfo > Polling Service List Interval Minutes). Remember to
reset the polling intverval after background processing has registered.
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Testing a separate background processing configuration
After you have installed Workflow 7.0 in a separate background processing
configuration and configured connections between your primary and secondary
servers, Symantec recommends testing the configuration. Test the configuration
by creating a Workflow-type project with timeouts, publish the project to both
servers, invoke the process from the primary server only, and then see if the
timeouts work. If the timeouts appear in the Log Viewer in the Logging and
Configuration Tool, you have successfully set up the separate background
processing configuration.

To test a separate background processing configuration

1 On the primary server, openWorkflowDesigner and create aWorkflow-type
project.

2 In theworkspace of the open project, add aGetCurrentDate component and
connect it after the Start component.

3 Add a Create Log Entry component after the Get Current Date component.

4 In the Create Log Entry editor, set the Log Entry Level to Error.

5 Add a Dialog Workflow component after the Create Log Entry component.

6 In the Dialog Workflow component editor, set the Task Source Type to
ProcessManagerTaskSource.

7 Under Task Assignments, assign the task to the All Users group.

8 Under the Event Configuration tab, add two escalations set at two and four
minutes respectively.

9 In theDecisionModel of each escalation, add aCreateLogEntry component
set to the Error level.

10 Under the Event Configuration tab, under Timeout Configuration, set the
timeout span to five minutes.

11 In the Timeout Process, add a Create Log Entry component set to the Error
level.

12 Under the Event Configuration tab, open the Start Process and add a Send
Email component.

Configure the Send Email component to send an email to an address you can
access. In the HTML Content, add the ResponsePageLink.

13 Save and publish your project to both your primary and secondary servers.

14 Run the process on only the primary server. Do not run it on the secondary
server.
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15 Wait at least five minutes so that the escalations run.

16 On the secondary server, open the Logging and Configuration tool, and then
look under the Log Viewer tab.

If the error level logs from your test project appear in the Log Viewer, you
have successfully installed Workflow 7.0 in the separate background
processing configuration.

Installing Workflow Server
See “Installing Workflow for the first time” on page 14.

If you are upgrading from Workflow 6.5, see the following section:

See “Upgrading from Workflow 6.5” on page 15.

After youhave installedWorkflowSolution in the Symantec InstallationManager
and downloaded the installation file through the SymantecManagement Console,
you are ready to install Workflow Server.

See “About installing Workflow 7.0” on page 13.

See “Installing Workflow Solution through Symantec Installation Manager”
on page 21.

See “Downloading the Workflow installer through the Symantec Management
Console ” on page 22.

Workflow 7.0 has a single installer. Although you must install Workflow Server,
installing other pieces of Workflow 7.0 is optional. During installation you can
select which pieces you want to install on the local computer.

See “About Workflow 7.0” on page 9.

See “Installing Workflow Designer” on page 29.
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To install Workflow Server

1 Run the Workflow installer.

The installer is located in the directory towhich you downloaded it. By default
the Workflow installer is downloaded to the desktop. If you have not yet
downloaded the installer, you can download it through the Symantec
Management Console.

See “Downloading theWorkflow installer through theSymantecManagement
Console ” on page 22.

2 In the Server Roles step, click the pieces of Workflow 7.0 that you want to
install on the local computer, and then click Next.

If you want to install only Workflow Server, select only that piece. The
installation steps on the left are affected by the options that you choose. The
more options you select on the right, themore steps youwill have on the left.

See “About Workflow 7.0” on page 9.

Backgroundprocessing refers tonon-humanprocess actions, suchas timeouts
and escalations. If you check the check box to enable background processing,
background processing will run on the local computer. If you uncheck the
check box to enable background processing, that processing will not run at
all. You can install background processing on a different computer. Installing
backgroundprocessingonadifferent computermayenhance theperformance
of Workflow 7.0. To install background processing on a different computer,
run the Workflow 7.0 installer on that computer and enable background
processing.

ClickingShowAdvancedSettingsDuringInstallation lets youedit thedefault
installation location and ORM settings.

3 On the Server Configuration step, select which Web site and base URL you
want to use.

The Web site mentioned here is the IIS Web site to which your projects will
be published by default.

Base URL refers to a resolvable URL to access the Workflow Server. If you
are installing on a design-only computer (not a publishing server), the base
URL can be the local computer name or IP address. If you are installing on a
publishing server with an externally accessible URL, use that URL.

The Task Tray is one of the client tools of Workflow 7.0. Leave the check box
marked to run it after installation.

4 On the Notification Server Credentials step, configure the NS options.

Contact your network administrator if you need help.
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5 On the Workflow Persistence step, click a persistence option.

Note: If you are currently runningWorkflow 6.5,make sure you use the same
persistence settings for Workflow 7.0.

If you install Workflow 7.0 with different persistence settings than your
currently running 6.5 version, all current tasks will become non-functional.

See “Upgrading from Workflow 6.5” on page 15.

See “Determining a project's persistence setting” on page 17.

If you cannot determine your persistence setting from Workflow 6.5, use
Exchange for your Workflow 7.0 installation.

6 After you have passed the system check, click Next and then click Install.

You will be notified when the installation has completed successfully.

Installing Workflow Designer
If you are upgrading from Workflow 6.5, see the following section:

See “Upgrading from Workflow 6.5” on page 15.

After you have installed Workflow Solution through the Symantec Installation
Manager anddownloaded the installation file through the SymantecManagement
Console, you are ready to install Workflow Designer and Process Manager.

See “About installing Workflow 7.0” on page 13.

See “Installing Workflow Solution through Symantec Installation Manager”
on page 21.

See “Downloading the Workflow installer through the Symantec Management
Console ” on page 22.

Workflow 7.0 has a single installer. Although you must install Workflow Server,
installing other pieces of Workflow 7.0 is optional. During installation you can
select which pieces you want to install on the local computer.

See “About Workflow 7.0” on page 9.

You can install Workflow on as many client computers as you need.

See “Installing Workflow Server” on page 27.

29Installing Workflow 7.0
Installing Workflow Designer



To install Workflow Designer

1 Run the Workflow Solution Setup file.

The installer is located in the directory towhich you downloaded it. By default
the Workflow installer is downloaded to the desktop. If you have not yet
downloaded theWorkflow installer, youcandownload it through theSymantec
Management Console.

See “Downloading theWorkflow installer through theSymantecManagement
Console ” on page 22.

2 In the Server Roles step, click the pieces of Workflow 7.0 that you want to
install on the local computer, and then click Next.

See “About Workflow 7.0” on page 9.

If you want to install only Workflow Server, select only that piece. The
installation steps on the left are affected by the options that you choose. The
more options you select on the right, themore steps youwill have on the left.

You should always check Workflow Server.

ClickingShowAdvancedSettingsDuringInstallation lets youedit thedefault
installation location and ORM settings.

3 On the Server Configuration step, select which Website and base URL you
want to use.

The Website mentioned here is the IIS Website on which your projects will
be published.

Base URL refers to a resolvable URL to access the Workflow Server. If you
are installing on a design-only computer (not a publishing server), the base
URL can be the local computer name or IP address. If you are installing on a
publishing server with an externally accessible URL, use that URL.

4 On the Workflow Designer Tasks step, configure the installation options.

Old Tool Preferences refers to task tray application settings and Workflow
Designer tool settings (configured in File > Edit Tool Preferences in the
Workflow loading window) carried over from your previous installation of
Workflow.

5 On theNotificationServerCredentials step, configure theNotificationServer
options.

Contact your network administrator if you need help.
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6 On the Workflow Persistence step, click a persistence option.

Note: If you are currently runningWorkflow 6.5,make sure you use the same
persistence settings for Workflow 7.0.

If you install Workflow 7.0 with different persistence settings than your
currently running 6.5 version, all current tasks will become non-functional.

See “Upgrading from Workflow 6.5” on page 15.

See “Determining a project's persistence setting” on page 17.

If you cannot determine your persistence setting from Workflow 6.5, use
Exchange for your Workflow 7.0 installation.

7 After you have passed the system check, click Next and then click Install.

You will be notified when the installation has completed successfully.

Installing Process Manager
If you are upgrading from Workflow 6.5, see the following section:

See “Upgrading from Workflow 6.5” on page 15.

After you have installed Workflow Solution through the Symantec Installation
Manager anddownloaded the installation file through the SymantecManagement
Console, you are ready to install Workflow Designer and Process Manager.

See “About installing Workflow 7.0” on page 13.

See “Installing Workflow Solution through Symantec Installation Manager”
on page 21.

See “Downloading the Workflow installer through the Symantec Management
Console ” on page 22.

Workflow 7.0 has a single installer. Although you must install Workflow Server,
installing other pieces of Workflow 7.0 is optional. During installation you can
select which pieces you want to install on the local computer.

See “About Workflow 7.0” on page 9.

You can install Workflow on as many client computers as you need.

See “Installing Workflow Server” on page 27.
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To install Process Manager

1 Run the Workflow Solution Setup file.

The installer is located in the directory towhich you downloaded it. By default
the Workflow installer is downloaded to the desktop. If you have not yet
downloaded theWorkflow installer, youcandownload it through theSymantec
Management Console.

See “Downloading theWorkflow installer through theSymantecManagement
Console ” on page 22.

2 In the Server Roles step, click the pieces of Workflow 7.0 that you want to
install on the local computer, and then click Next.

See “About Workflow 7.0” on page 9.

If you want to install only Process Manager, select only that piece. The
installation steps on the left are affected by the options that you choose. The
more options you select on the right, themore steps youwill have on the left.

If youwant to install theProcessManagerDatabase and theProcessManager
Portal on the same computer, select both of them and click Next. You should
always click Process Manager Portal Core if you are installing Process
Manager.

You should always clickWorkflow Server and background processing unless
you have a specific reason for not doing so.

ClickingShowAdvancedSettingsDuringInstallation lets youedit thedefault
installation location, database replication, advanced cube reporting, system
accounts access (ASPNET, Network Service), and ORM settings.

3 On the Server Configuration step, select which Website and base URL you
want Process Manager to use.

Base URL refers to a resolvable URL to access the Workflow Server. If you
are installing on a design-only computer (not a publishing server), the base
URL can be the local computer name or IP address. If you are installing on a
publishing server with an externally accessible URL, use that URL.

4 On theNotificationServerCredentials step, configure theNotificationServer
options.

Contact your network administrator if you need help.

5 On the Database Connection step, configure a connection to a Process
Manager database.

6 On the Database Configuration step, configure whether you are installing a
new database or updating an existing database.

Installing Workflow 7.0
Installing Process Manager

32



7 On the Database Replication, configure a replication database.

8 On theAdvancedCubeReporting step, install and configure cube reporting.

9 On the System Accounts Access step, configure which system accounts can
access the Process Manager database.

10 On the ProcessManagerConfiguration step, configure the virtual directory
for Process Manager and the other settings.

11 On theProcessManagerAuthentication step, configure the ID andpassword
for the administrator user and the type of authentication.

If you choose Active Directory authentication, click Add to add an Active
Directory server.

■ ADServerDomain: this is thenameof the domain or theADhost computer
name.

■ Email DomainName: this is the email address for theADdomain. You can
set this however you want.

■ Auto Create Users on Initial Login: this option syncs Process Manager
with Active Directory while Process Manager is installing. Symantec
recommends using this option.

■ Default User Groups: checking the All Users group sets the Active
Directory All Users group to sync with the Process Manager All Users
group. Symantec recommends using this configuration.

■ Dynamically Select TimeZone: this option uses the time zone of the local
computer accessing Process Manager.

■ AD Server TimeZone: this is the time zone of the Active Directory host
server.

■ Container: this is the item group that will be transferred to Process
Manager. Symantec recommends selecting Users.

■ Credentials to connect to AD: credentials used by Process Manager to
connect with Active Directory. Use administrator credentials.

12 After configuring the Active Directory server, click OK.

Thewizard pauses for amoment to attempt to connectwithActiveDirectory.
If the connection fails, a dialog box opens with a failure message. If the
connection succeeds, the wizard returns to the Process Manager
authentication screen.
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13 On the Workflow Persistence step, click a persistence option.

Note: If you are currently runningWorkflow 6.5,make sure you use the same
persistence settings for Workflow 7.0.

If you install Workflow 7.0 with different persistence settings than your
currently running 6.5 version, all current tasks will become non-functional.

See “Upgrading from Workflow 6.5” on page 15.

See “Determining a project's persistence setting” on page 17.

If you cannot determine your persistence setting from Workflow 6.5, use
Exchange for your Workflow 7.0 installation.

14 On the Symbus ORM step, configure the ORM.

15 After you have passed the system check, click Next and then click Install.

You will be notified when the installation has completed successfully.

Configuring Workflow 7.0
Once you have installed Workflow 7.0, you are ready to configure it.

See “About Workflow 7.0” on page 9.

See “Installing Workflow Solution through Symantec Installation Manager”
on page 21.

See “Downloading the Workflow installer through the Symantec Management
Console ” on page 22.

See “Installing Workflow Server” on page 27.

See “Installing Workflow Designer” on page 29.

See “Licensing Workflow Server, Workflow Designer, and Process Manager”
on page 37.

See “Migrating links from Notification Server 6.5 to Symantec Management
Platform 7.0” on page 35.

Configuration involves the following steps:
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Table 2-2 Process for configuring Workflow 7.0

DescriptionActionStep

During the installation process you
have the option of migrating from
NotificationServer 6.5.Migration is not
required. Migration brings all of your
oldpublishedprojects fromNotification
Server 6.5 into SymantecManagement
Console 7.0. Migrated processes are
non-functional until you republish
them.

See “Migrating links from Notification
Server 6.5 to Symantec Management
Platform 7.0” on page 35.

Migrating processes from
Notification Server 6.5

Step 1

After you installWorkflow, you should
apply a license.

See “Licensing Workflow Server,
Workflow Designer, and Process
Manager” on page 37.

License Workflow Server,
Workflow Designer, and Process
Manager

Step 2

Using Workflow's component
generators, build theAltiris component
libraries for components that can
integrate with the Altiris solutions.

For more information about building
theAltiris component libraries, see the
Workflow 7.0 User's Guide.

Build the Altiris component
libraries

Step 3

Importing the Altiris components into
a project makes them available for you
to use.

For more information about building
theAltiris component libraries, see the
Workflow 7.0 User's Guide.

Import the Altiris component
libraries

Step 4

Migrating links from Notification Server 6.5 to Symantec Management
Platform 7.0

See “Configuring Workflow 7.0” on page 34.

You can migrate the links to all your published Notification Server 6.5 projects
to Symantec Management Platform 7.0 when you install Workflow 7.0 through
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theSymantec InstallationManager.However, insteadofmigrating, you can simply
republish allNotificationServer 6.5 processes to the 7.0 platformserver.Migrating
yourpublishedprojects doesnot bring themover to the7.0 SymantecManagement
Platform server in a functional form; they will be broken when they come over to
7.0. All 6.5 projectsmust be updated with 7.0 components and republished on the
7.0 server for them towork. Therefore, you should republish instead ofmigrating.
The only advantage of migration is seeing links to your projects in the Symantec
Management Console. It can be helpful to see them in the 7.0 console even though
they will not work until you republish the projects to the 7.0 platform server.

Youhave the option ofmigrating the links to all your publishedNotificationServer
6.5 projectswhile installingWorkflow7.0 throughSymantec InstallationManager.
Migrating is easier if you have not yet installed SymantecManagement Platform.
If you have installed the platform, you can still migrate, but there are some
additional steps.

To migrate links from Notification Server 6.5

1 On your Symantec Management Platform 7.0 server, install Workflow 7.0
through Symantec Installation Manager.

You do not need to have SMP installed on the server yet to install Workflow
7.0.

See “To install Workflow 7.0 through the Symantec Installation Manager”
on page 22.

2 At the end of the installation, click Run Notification 6 Migration Wizard,
and then click Finish.

3 In the dialog box that appears, click Get Migration Wizard install package
for Notification Server 6 data report. Do not click OK.

4 In the open dialog box, copy the Symantec_Migration_Package file over to
your Notification Server 6.5 computer.

Do not click OK on the Symantec Installation Manager dialog box yet.

For reference, the migration package on your 7.0 server is in C: > Program
Files > Symantec Installation Manager > MigrationPackage.

5 On your 6.5 server, run the Symantec_Migration_Package executable file.

You should see the following dialog box when it is finished:

6 Click Ok.
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7 Complete theNotification Server upgradewizard.Whenyou see theExporter
Configuration dialog box, on the left, uncheck all the solutions except for
Workflow Solution, and then click Next.

If Workflow 7.0 does not appear in the list, abort migration.

8 Click Next even if you see the message, Fails to meet baseline requirements.

If you see a dialog box indicating that the product readiness check has not
been satisfied by Workflow, click Yes.

9 Click Next.

10 When the data export finishes, click Finish.

11 Navigate toC:>ProgramFiles>Altiris>Upgrade>Data and copy the newly
created .adb file over to your 7.0 server.

The files in C: > Program Files > Altiris > Upgrade > Data are named by date.
Make sure that you get the file with the correct date.

12 After you have copied over the .adb file, on your 7.0 server click OK on the
Notification Server 6 Migration Wizard Instructions dialog box.

13 In the resulting dialog box, click Browse, and select the .adb file that you just
moved over from your 6.5 server.

14 Click Next.

15 In theExporterConfigurationdialog box, on the left, uncheck all the solutions
except Workflow Solution, and then click Next.

If Workflow 7.0 does not appear in the list, abort migration.

16 Complete the wizard.

17 To see your migrated links, open the Symantec Management Console and
click Manage > Workflows.

Your migrated project links appear in the tree structure on the left under
Published Workflows.

Licensing Workflow Server, Workflow Designer, and Process Manager
See “Configuring Workflow 7.0” on page 34.

Workflow is not licensed by the designer or server computer but only by the
Symantec Management Platform server. Once a platform server has a Workflow
license, you can have as many Workflow installations as you want, provided that
those installations have access to the platform server.

For information about adding licenses, see theWorkflow 7.0 User's Guide.
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See “Where to get more information about Symantec Workflow 7.0” on page 12.

The following table lists and describes the three licensing levels of Workflow 7.0.

Table 2-3 Levels of Workflow 7.0

DescriptionLicensing level

This is the lowest license level. The Symantec
Management Platform comes equipped with Process
Automation Server. You can run as many Process
Automation Servers as you would like.

Process Automation Server includes the following
features:

■ Integration with only Platform-based solutions

■ Only the eight Platform component generators are
available in Workflow Designer

■ Basic Process Manager

This includes full customization, some pre-built
webparts, organization management, Active
Directory integration, task list, and service catalog.

■ Full component API

The full componentAPI is available for developers.

Process Automation Server

This is themiddle license level.Workflow 7.0 requires
an additional license; it does not come with the
Symantec Management Platform. When you add a
Workflow 7.0 license through the Symantec
ManagementConsole, anyProcessAutomationServers
that are connected to it become fully licensedWorkflow
7.0 Servers that can communicate with any external
system (not only platform solutions).

Workflow 7.0 license level includes the following
features:

■ Integration with any system (not only
Platform-based solutions)

■ All componentgenerators areavailable inWorkflow
Designer

■ Full Process Manager

This includes all the functions of the basic Process
Manager, and it adds process viewpages, reporting,
knowledge base, and document management.

■ Full component API available

The full componentAPI is available for developers.

Workflow 7.0
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Table 2-3 Levels of Workflow 7.0 (continued)

DescriptionLicensing level

The Workflow 7.0 Enterprise option is not currently
available.

Workflow 7.0 Enterprise option
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